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About this guide
This guide introduces the Customization Tool Kit and describes the process for customizing elements of the 
WBI and CLI for AssuredSAN storage systems.

Intended audience
This guide is intended for 

• Storage system administrators.
• Configuration managers.
• Web GUI developers.

Prerequisites
Prerequisites for using this product include knowledge of:

• Network administration.
• Storage system configuration.
• Image editing and creation.

Related documentation

* Printed document included in product shipkit.

For additional information, see Dot Hill's Customer Resource Center web site: http://crc.dothill.com.

For additional information about Perl installations and required modules see: http://www.perl.org/

For information about See

Enhancements, known issues, and late-breaking 
information not included in product documentation

Release Notes

Overview of product shipkit contents and setup tasks Getting Started*

Regulatory compliance and safety and disposal 
information

AssuredSAN Product Regulatory Compliance and Safety*

Using a rackmount bracket kit to install an enclosure 
into a rack

AssuredSAN Rackmount Bracket Kit Installation* or 
AssuredSAN 2-Post Rackmount Bracket Kit Installation*

Product hardware setup and related troubleshooting AssuredSAN 4000 Series Setup Guide

Using the CLI to configure and manage the product AssuredSAN 4000 Series CLI Reference Guide

Event codes and recommended actions AssuredSAN 4000 Series Service Guide

Identifying and installing or replacing FRUs AssuredSAN 4000 Series Service Guide

http://crc.dothill.com
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Document conventions and symbols

CAUTION: Indicates that failure to follow directions could result in damage to equipment or data.

IMPORTANT: Provides clarifying information or specific instructions.

NOTE: Provides additional information.

TIP: Provides helpful hints and shortcuts.

Table 1 Document conventions

Convention Element

Blue text Cross-reference links and e-mail addresses

Blue, underlined text Web site addresses

Bold font • Key names
• Text typed into a GUI element, such as into a box
• GUI elements that are clicked or selected, such as menu and list items, 

buttons, and check boxes

Italics font Text emphasis

Monospace font • File and directory names
• System output
• Code
• Text typed at the command-line

Monospace, italic font • Code variables
• Command-line variables

Monospace, bold font Emphasis of file and directory names, system output, code, and text typed at the 
command line
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1 Getting Started
You can use the Customization Tool Kit (CTK) to alter the appearance of WBI screens and panels and the 
CLI for product, corporate, or marketing requirements.

With the CTK, you can:

• Replace default WBI files with customized files, created using a text or image editor.
• Review changes made to the WBI.
• Hide Dot-Hill-specific information in the CLI.

The CTK is a set of Perl-based scripts that places editable files in a “Sandbox” directory for customization, 
places all necessary files (edited, unedited, and non-editable) in a staging directory for a testing, and 
packages all necessary files for return to Dot Hill Systems for validation and deployment. 

The CTK is not an editor. Third-party editing tools are required to make changes to text and image files; 
such tools are not included in the CTK installation. Installation and usage of those third party tools falls 
outside the scope of this document. 

Tools for customizing files
Two general types of files may be customized: text and image. Choose editing tools that adhere to the 
following criteria.

Text editing requirements:

• Save files leaving file type extensions in place
• Save files leaving line breaks in place
• Save files without transforming spaces (strip, trim, convert to tabs, and so forth)
• Save files without adding meta-tags (word processing applications are not recommended)
• Check for well-formedness (for mark-up files such as HTML)

Image editing requirements:

• Create, edit, and save Portable Network Graphics (.png) files with transparency intact
• Create, edit, and save Graphics Interchange Format (.gif) files with transparency intact
• Create, edit, and save Favicons

Use a web browser to preview the customization. Supported web browsers are:

• Mozilla Firefox 3 or later, or 
• Microsoft Internet Explorer 8 or later

Understanding automatic changes to the user interfaces
Several changes occur in both the WBI and CLI simply by installing a customization file. These changes 
hide references to “Dot Hill” or “AssuredSAN” and protect the OEM nature of Dot Hill’s relationship with 
its partner.

These changes affect the system only after the customization file created in this process has been installed. 

WBI and CLI changes • Enclosure model is hidden
• Enclosure vendor is hidden
• SCSI Product ID is hidden
• SCSI Vendor ID is hidden

CLI only changes • Parameter added to the show system command displays SCSI Vendor 
ID and SCSI Product ID for auditing or confirmation purposes. 
This command is restricted to customized systems and does not appear in 
other documentation. 
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Determining what level of customization is appropriate
Because so many aspects of the WBI can be customized, determine what level of customization is required 
in advance. 

Considering a tiered approach
A tiered approach allows you to separate the changes into easily managed, progressively more involved 
tasks as time or resources allow.

Tier 1 - Change the application name and logos, favicon, and product and brand IDs. This can be used for 
quick re-branding, or in situations where extensive changes are not needed or fall outside the scope of 
allotted time or effort. Signing in to RAIDar is, also, easily changed in this tier with the caveats described 
below.

Tier 2 - Change the above, and color scheme for banners, tabs, buttons, panes (System Status, 
Configuration View, System Overview), selection highlighting, and tree trunks and branches.

Tier 3 - Change the above, and icons that represent system components (such as vdisks and volumes) and 
statuses (such as component health and event severity). Changing SCSI product and vendor IDs is an 
option, but should only be done after reviewing Changing SCSI ID values on page 8 and Editing 
restrictions on page 17, and fully understanding the affects this has on your system.

IMPORTANT: The AssuredSAN 4000 Series RAIDar User Guide describes the baseline colors denoting 
storage space. Changing the colors of storage space color codes does not impact functionality; however, 
you should note changes to those colors so users of that documentation are aware of the new values.

Changing SCSI ID values
The CTK allows you change the SCSI vendor ID and SCSI product ID. These values must be changed 
together, and only when you have officially assigned IDs. Unqualified IDs may invalidate certifications and 
cause incompatibilities with existing software. Re-branding alone does not require recertification; however, 
changing the SCSI vendor or product IDs might.

CAUTION: Host access may fail if the SCSI vendor ID or SCSI product ID are changed to unqualified 
values. Do not change these values separately, or without officially assigned IDs.

When changing the scsi-vendor-id and scsi-product-id values, ensure that you accurately enter 
the appropriate values and adhere to guidance provided in Editing restrictions on page 17. After 
customization, these values no longer appear by default in the WBI or CLI and are only displayed through 
the CLI via the show system detail command. These values do not appear in the WBI mock-up 
provided for testing purposes. 

The customization script performs a rudimentary check of the scsi-vendor-id and 
scsi-product-id values. This check does not ensure the validity of the values, but merely checks for 
appropriate length. Max length for scsi-vendor-id is eight characters and scsi-product-id is 16 
characters.

Because of potential adverse consequences, changing scsi-vendor-id and scsi-product-id 
values should be reserved for users who fully understand these values’ functions and are prepared to 
troubleshoot issues arising from these changes.

Support for changing the SCSI vendor ID and SCSI product ID, software recertification and certification 
transfer fall outside the scope of this document.
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Using the CLI and RAIDar
This provides a brief introduction to the CLI and RAIDar. Use this information to test your customizations 
after you have installed the packet. For more information, see the AssuredSAN 4000 Series CLI Reference 
Guide and AssuredSAN 4000 Series RAIDar User Guide.

CLI
The CLI software embedded in the controller modules enables you to manage and monitor storage-system 
operation.

Signing in to the CLI
1. Access the CLI using one of the following options:

• Use Telnet, an SSH application, or a terminal emulator on a management host that is remotely 
connected through a LAN to a controller module’s network port. See the AssuredSAN 4000 Series 
Setup Guide for information about setting management port IP addresses using the CLI.

• By using a terminal emulator on a management host that is directly connected to a controller 
module’s serial CLI port.

2. When prompted with login, enter the user name and press Enter. The default user name is manage.
3. When prompted with password, enter the password and press Enter. The default password is 

!manage.

If you are logging in to the CLI for the first time, the Language field displays user setting or English, 
either of which results in English.

Commands
SCSI ID values display in two commands, show inquiry and show system.

Command references that include a See Also section include two types of references. Commands in blue 
with a page number are commands referenced in this guide. All other references, in black, can be found in 
the AssuredSAN 4000 Series CLI Reference Guide.

NOTE: Command references in the See Also section can be found in the AssuredSAN 4000 Series CLI 
Reference Guide

show inquiry

Description Shows inquiry data for each controller module.

Syntax show inquiry

Output • Product vendor name, product ID, and vendor ID
• MC firmware version and loader version
• SC firmware version and loader version
• Controller module serial number
• MAC address
• Network port IP address
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show system

Example Show inquiry data for a system in which controller B is not installed:

# show inquiry

Product Information

-------------------

Vendor Name: 

Product ID: model
SCSI Vendor ID: vendor

Inquiry Controller A

--------------------

Management Controller Code Version: L240R001

Management Controller Loader Code Version: 2.5

Storage Controller Code Version: T240R01

Storage Controller Loader Code Version: 23.008

Serial Number: SN
MAC Address: 00:C0:FF:29:41:60

IP Address: 10.134.1.100

Inquiry Controller B

--------------------

Management Controller Code Version: Not Present

Management Controller Loader Code Version: Not Present

Storage Controller Code Version: Not Present

Storage Controller Loader Code Version: Not Present

Serial Number: Not Present

MAC Address: Not Present

IP Address: Not Present

Success: Command completed successfully. (2012-01-18 15:05:25)

See also • versions

Description Shows information about the system. If the system’s health is not OK, each unhealthy component is 
listed with information to help you resolve the health problem.

Syntax show system

Output System Name
Storage system name. The default is Uninitialized Name.

System Contact
The name of person who administers the system. The default is Uninitialized Contact.

System Location
The location of the system. The default is Uninitialized Location.

System Information
A brief description of what the system is used for or how it’s configured. The default is 
Uninitialized Info.

Midplane Serial Number
The serial number of the controller enclosure midplane.

Vendor Name
Vendor name.

Product ID
Product model identifier.
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Product Brand
Product brand name.

SCSI Vendor ID
Vendor name returned by the SCSI INQUIRY command.

SCSI Product ID
Product identifier returned by the SCSI INQUIRY command.

Enclosure Count
Number of enclosures in the storage system. 

Health

• OK

• Degraded

• Fault

• Unknown

Health Reason
If Health is not OK, this field shows the reason for the health state.

PFU Status
PFU status.

Supported Locales
Supported display languages: English, Spanish, French, German, Italian, Japanese, Dutch, 
Chinese-Simplified, Chinese-Traditional, Korean.

Example Show information for a system whose health is OK:

# show system

System Information

------------------

System Name: Storage-1

System Contact: J. Smith

System Location: Main lab

System Information: Used for order processing data

Midplane Serial Number: SN
Vendor Name: vendor
Product ID: product
Product Brand: brand
SCSI Vendor ID: vendor-ID
SCSI Product ID: product-ID
Enclosure Count: 2

Health: OK

Health Reason:

PFU Status: Idle

Supported Locales: English, Spanish, French, German, Italian, Japanese, Dutch, 
Chinese-Simplified, Chinese-Traditional, Korean

Success: Command completed successfully. (2011-10-10 15:28:14)
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RAIDar
RAIDar is a web-based application for configuring, monitoring, and managing the storage system. 

Each controller module in the storage system contains a web server, which is accessed when you sign in to 
RAIDar. In a dual-controller system, you can access all functions from either controller. If one controller 
becomes unavailable, you can continue to manage the storage system from the partner controller.

RAIDar is also referred to as the WBI.

Browser setup
• Use Mozilla Firefox 3 or later, or Microsoft Internet Explorer 8 or later.
• To see the help window, you must enable pop-up windows.
• To optimize the display, use a color monitor and set its color quality to the highest setting.
• To navigate beyond the Sign In page (with a valid user account):

• Set the browser’s local-intranet security option to medium or medium-low. For Internet Explorer 8, 
adding each controller’s network IP address as a trusted site can avoid access issues.

• Verify that the browser is set to allow cookies at least for the IP addresses of the storage-system 
network ports.

Show information for a system whose health is degraded because of a problem with a vdisk:

# show system

System Information

------------------

System Name: Storage-2

System Contact: J. Smith

System Location: Main lab

System Information: Used for testing

Midplane Serial Number: SN
Vendor Name: vendor
Product ID: product
Product Brand: brand
SCSI Vendor ID: vendor-ID
SCSI Product ID: product-ID
Enclosure Count: 1

Health: Degraded

Health Reason: See the information about unhealthy components for guidance.

PFU Status: Idle

Supported Locales: English, Spanish, French, German, Italian, Japanese, Dutch, 
Chinese-Simplified, Chinese-Traditional, Korean

  Unhealthy Component

  -------------------

  Component ID: Vdisk vd01

  Health: Degraded

  Health Reason: The vdisk is not fault tolerant. Reconstruction cannot start

  because there is no spare disk available of the proper type and size.

  Health Recommendation: - Replace the failed disk.

  - Configure the new disk as a spare so the system can start reconstructing the

  vdisk.

  - To prevent this problem in the future, configure one or more additional disks

  as spare disks.

Success: Command completed successfully. (2012-01-19 10:37:52)

See also • set system
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Signing in to RAIDar
1. In the web browser’s address field, type the IP address of a controller network port and press Enter. The 

RAIDar Sign In page is displayed. If the Sign In page does not display, verify that you have entered the 
correct IP address.

2. On the Sign In page, enter the name and password of a configured user. The default user name and 
password are manage and !manage. If you are logging in to RAIDar for the first time, the Language 
field displays user setting or English, either of which results in English.

3. Click Sign In. If the system is available, the System Overview page is displayed; otherwise, a message 
indicates that the system is unavailable.

Tips for signing in and signing out
• Do not include a leading zero in an IP address. For example, enter 10.1.4.6 not 10.1.4.06.
• Multiple users can be signed in to each controller simultaneously.
• For each active RAIDar session an identifier is stored in the browser. Depending on how your browser 

treats this session identifier, you might be able to run multiple independent sessions simultaneously. 
Internet Explorer can run separate RAIDar sessions if you select New Session in the File menu. If you do 
not select this then all instances of Internet Explorer share the same session, as does Firefox.

• End a RAIDar session by clicking the Sign Out link near the top of the RAIDar window. Do not simply 
close the browser window.
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2 Using the Customization Tool Kit
Preparing the Perl environment

For the CTK to function properly, you must:

• Install the CTK on the same system as the Perl executable
• Have permission to run the Perl executable
• Map the .pl extension to the Perl executable (Windows)

Required installations
You must install:

• Perl 5.05 
• Win32::console::ANSI.pm (for Windows systems only)
• Image::Size.pm

• File::Copy::Recursive.pm

NOTE: Procedures for installing Perl and associated packages fall outside the scope of this document as 
installation varies from platform to platform and enterprise to enterprise. 

Installing the Customization Tool Kit
The CTK installation file, CTK.zip, contains the scripts and directories needed to customize the WBI.

To install:

1. Specify a location on the same system as the Perl executable and extract CTK.zip to that location. This 
creates the ctk directory.

2. In the ctk directory, open a command prompt. 
3. Run ctk.pl --p to finish installation. The following directory structure is created:

ctk

lib

Sandbox

Source

Staging

• The lib directory contains Perl scripts related to CTK functionality. 
• The Sandbox directory contains all customizable files.

CAUTION: Only edit files in the Sandbox. Editing other files will result in an invalid customization.

• The Source directory contains the baseline WBI interface files.
• The Staging directory will contain the customized WBI after running the customize option. The 

customized mock-up created in the Staging directory is for inspection and limited testing, and is 
neither deployed nor functional.

Running the Customization Tool Kit
The CTK runs with parameters from a command prompt with the syntax ctk.pl --parameter, where:

• ctk.pl runs the script
• parameter determines the action taken by the script
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Running ctk.pl without a parameter displays the CTK Help.

NOTE: This document does not include the command prompt or Perl invocation when describing the script 
or parameters as Perl functionality may differ from platform to platform.
For example, C:\ctk>perl ctk.pl --p might be written as ctk.pl --p. 

Using appropriate parameters
The CTK consists of one script that performs several functions. Use parameters to direct script function. A 
parameter is specified using either the first letter or the full word. Parameters --p and --prepare are 
equivalent. In Table 2, the full word option appears in brackets.

Preparing to customize the interface
To create a sandbox, run ctk.pl --p

This places editable files in the Sandbox directory of the Customization Toolkit and creates a viewable 
index.html file in the Staging directory. 

Customizing the interface

CAUTION: Failure to adhere to the Editing restrictions when customizing your interface may result in loss 
of data or failure to build the customization.

The customization process follows the iterative pattern of edit, build, test, repeat. The build step is required 
to assemble the customized and non-customized files in the Staging directory.

Only customize files in the sandbox. This location segregates files available for customization while 
protecting important files that should not be changed. 

1. Determine which files need to be edited for this customization. See Determining what level of 
customization is appropriate on page 8 and Customizable files on page 21 for an overview of 
customizable files and their associated functionality.

Table 2 CTK Parameters and functions

Parameter Function

--b[undle] Packages the customization for delivery to Dot Hill Systems for 
validation.

--c[ustomize] Builds a mock-up of the customized WBI for inspection and limited 
testing in the Staging directory. This option does not deploy the 
customization, nor is the WBI in the Staging area functional. 

--h[elp] Displays a quick summary of available parameters

--l[oad] Places a previously bundled customization in the Sandbox directory, 
then builds the Staging directory based on those customizations. 
This overwrites any customization that may exist in either directory.

--p[repare] Copies editable files from the Source to the Sandbox directory, 
and builds a version of the WBI in the Staging directory. Files that 
have been customized are not over-written with this option. 

--p[repare] 
--f[orce]

Copies editable files from the Source to the Sandbox directory, 
and builds a version of the WBI in the Staging directory. Prepare 
and Force together differ from Prepare alone in that files that 
have been customized are over-written. 
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2. Edit files as appropriate for the customization plan. Strictly adhere to Editing restrictions.
3. Run ctk.pl --c to build a customized version of the WBI. 
4. Exit any browser window displaying the WBI.
5. Open a new browser window and clear the browser cache. 

IMPORTANT: As browsers cache pages, skipping step 4 and step 5 may result in a previous 
version being displayed.

6. In the Staging directory, click index.html to open the test WBI in a browser.
7. Test the customization. See Testing the customized interface on page 18.
8. Repeat from step 1, as necessary, to complete the customization.

IMPORTANT: Perform all customizations in the Sandbox directory. The Staging directory is 
volatile and changes made there are overwritten the next time ctk.pl --c is run.

Editing restrictions
Observe these restrictions when customizing files.

CAUTION: Failure to adhere to these restrictions may result in loss of data or failure to build the 
customization.

In general:

• Do not add unnecessary files to any ctk directory. Store temporary, work, or notes files in a directory 
outside of the ctk directory.

• Do not rename files. Files must keep the same name as the original. 
• Maintain the same file type as the original. Simply changing a file extension is not adequate, files must 

be saved as that file type.

Graphics files:

• Custom graphics files must be the same dimensions and type as the original files unless otherwise 
stated in All customizable WBI images on page 25.

• Duplicate files with differing extensions exist in the images directory. Files with the .gif extension are 
included for backwards compatibility only. Files with the .png extension are used in current browser 
versions. These files should be identical in appearance to maintain consistency from browser to 
browser. 

In the brandInfo.ini file:

• Do not enter spaces before or after the ‘=’ 
• Change the vendor-name, product-id, and product-brand as needed. These are not 

programmatic values and do not affect functionality. These values, also, accept multi-byte Unicode 
characters. 

• Avoid changing the scsi-vendor-id and scsi-product-id. See Changing SCSI ID values on 
page 8 for more information.

In other text files:

• Check mark-up files such as HTML files for well-formedness after editing. 
• Express colors in hexadecimal format. That is, enter blue as ‘#0000FF’ rather than ‘blue’.
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Customizing buttons and tabs
Tabs and buttons are a special case as they consist of two images per state per size: The left edge and the 
remainder, or the right portion, where text is displayed. When customizing buttons and tabs, ensure that 
both left and remainder files for all sizes and all states are customized.

Note there are subtle differences in color for each tab and button in Table 3 on page 18. These differences 
represent different states. The different states for controls are:

• disabled
• down (buttons only)
• emphasized
• normal 
• selected (tab only)
• over

Testing the customized interface
In the Staging directory, open index.html in a web browser. This presents an operational mock-up of 
the WBI. For testing purposes, the sign-in page does not require a username or password.

Because of the high level of customization available, the person doing the customization is best suited to 
determine what aspects of the WBI need to be tested.

During testing, consider:

• Correct spelling for textual changes.
• Color matches between panes. 

Table 3 Button and tab structures

Function Left Remainder

Button normal

Button emphasized 
(focus)

Button over (hover)

Button down (press)

Button disabled

Tab normal 

Tab emphasized (focus)

Tab over (hover)

Tab selected

Tab disabled
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• Color matches between states of items. 
• Appropriate changes in button appearance during “over,” “down,” and “disabled” operation.
• Appropriate contrast between font and background colors.
• Appropriate messaging from Health, Status, and other communication icons.
• Desired appearance of WBI Help pages.

IMPORTANT: If the SCSI Product ID and SCSI Vendor ID have been changed, ensure the entered values 
are correct and qualified.

Functionality cannot be customized. If errors occur, or if the presentation of information changes beyond 
what has been customized, functional errors may have been introduced during the customization process. 
For more information about correcting functional errors in the WBI that have been introduced during the 
customization process, see  on page 19.

To test the WBI:

1. Verify names and logos that you changed on the sign-in page.
2. Sign in and browse the component and task panels to verify text and graphics that you changed.
3. In the Configuration View panel, right-click on the system and select View > Test Buttons to view buttons 

in all states of activity.
4. In the Configuration View panel, right-click on the system and select View > Test Tabs to view tabs in all 

states of activity.
5. Click the Help icon and view text and graphics changes for the help window.

Restoring the baseline WBI
If you introduced errors during the customization process, or if the default presentation is preferred, run 
ctk.pl --p --f to overwrite all Sandbox directory files with the original source code, remove all 
customizations, and restore the original interface in the Staging directory.

CAUTION: Returning to a baseline WBI eliminates all changes. Only perform this procedure to return to a 
baseline WBI interface, or to eliminate functional errors introduced during customization.

CTK logic assumes that the Source directory has not changed. If errors have been introduced because of 
changes made in the Source directory, you must re-install the CTK. See Installing the Customization Tool 
Kit on page 15.

Packaging the customized interface
Once you thoroughly test and are satisfied with the customized WBI:

1. Run ctk.pl --b to package the finished customization. This creates a CUSTOMIZATION.zip in the 
ctk directory. 

2. Forward the CUSTOMIZATION.zip to your Dot Hill Systems Engineer.

Dot Hill Systems validates the customized WBI and is the final arbiter for implementation. 

IMPORTANT: You are responsible for creating a valid customization. Dot Hill Systems does not provide 
GUI development services. 

Once the customization has been verified, Dot Hill will provide a binary customization image (.bin file) 
that can be installed on your controllers. You are responsible for updating your controllers with the file.
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A Customizable files
This appendix describes interface elements and associated files that you can customize. It follows the tiered 
approach suggested on page 8.

NOTE: Logos and application names may change without notice as newer versions of the AssuredSAN 
storage system become available.

Tier One customization
Figure 1 and Table 4 show commonly customized Tier One elements on the sign-in and main pages.

Figure 1 Tier One
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5
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1

4

3

7
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Table 4 Tier One callouts  

Callout Description Editable file and variable Comments

1 Favorites icon favicon.ico Displays in the address bar of the 
browser window, and on tab in a 
tabbed display. 
This icon is visible only when the 
page is served to the browser.

2 Application or 
company logo

signin_logo.png May be sized 100–300px wide, 
50-100px high

3 Application banner 
image

signin_image.png Appears on sign-in screen only. 
Size 100px wide by 100px high.

4 Smaller application 
or company logo

masthead_logo.png Size 76px wide by 39px high. 
Usually a smaller version of the 
application or company banner 
on the sign-in page.

5 Application name brandInfo.ini
applicationTitle

See Editable text files on 
page 25 for important 
information about editing text 
values.6 Abbreviated 

application name in 
Help

brandInfo.ini
applicationTitleAbbrev

7 System overview 
information such as 
vendor and product 
names

brandInfo.ini
vendor-name
product-id
product-brand
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Tier Two customization
Figure 2 and Table 5 show commonly customized Tier Two elements on the sign-in and main pages.

Figure 2 Tier Two

Table 5 Tier Two callouts

Callout Description Editable file and variable 

1 Sign-in banner color 1-CSSColors.tag
BrandMainColor 

2 Buttons images/buttons/ButtonName.png

3 Pane banners bartitle.png
bartitle_large.png
overviewtitle.png

4 Tree expand all, 
collapse all buttons

images/CE_Button*.png

2

1

3

5

6

7

4
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Tier Three customization
Figure 3 and Table 6 show commonly customized Tier Three elements on the main page.

Figure 3 Tier Three

5 Selection highlighting 1-CSSColors.tag
SelectColor 

6 Tree trunk and 
branches

7 Tree show/hide 
controls

Table 5 Tier Two callouts (continued)

Callout Description Editable file and variable 

Table 6 Tier Three callouts

Callout Description Editable file Comments

1 Event icons status_state_icon[_small]
.png

Size icons to 15px wide by 15px 
high
Size small icons to 9px wide by 
9px high
State represents the differing 
conditions. See Customizing 
buttons and tabs on page 18.

2 Health icons status_state_icon[_small]
.png

3 Component icons Files in the tree subdirectory that do 
not begin with tree- or tv-

Size icons to 29px wide by 20px 
high

1

3

2
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Editable text files
These text files control display and connection information, and control colors used in the application. 

All customizable WBI images
This section lists all elements that might be changed, by Usage (the general functional location of the 
image).

Table 7 Editable values in brandInfo.ini 

Property Value use Visible in

vendor-name Vendor name displayed in System 
Information

WBI, CLI

product-id Product ID displayed in System Information WBI, CLI

product-brand Product brand displayed in System 
Information

WBI, CLI

scsi-product-id SCSI IDs must be qualified. Host access 
may fail if the SCSI IDs are changed to an 
unqualified ID.

SCSI IDs are controlled by T10, a 
subcommittee of the InterNational 
Committee on Information Technology 
Standards (INCITS). 

Hidden. See Determining what 
level of customization is 
appropriate on page 8 for more 
information.

scsi-vendor-id

applicationTitle Title displayed in application banner WBI, CLI

applicationTitleAbbrev Abbreviated title displayed in application 
Help

WBI Help

trialLicensing Controls the availability of temporary 
licensing. Value must be set to true or 
false.

See Signing in to RAIDar on page 13 for 
more information. 

WBI

Table 8 Editable values in 1_CSSColors.tag

Color Palette Section Usage

Theme Color These colors are used in the application banner

General Functional Colors Colors used in common functionality such as selections, table rows, and 
text colors

Application Specific Colors Colors used in specific application controls or displays in the applications. 
Names are descriptive of functionality.

Table 9 Throughout

Image Description File Width Height

Primary tab background tabs/LargeBar.png 8 32

Primary tab right background, disabled tabs/LargeDisabled.png 398 32
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Primary tab left background, disabled tabs/LargeDisabledLeft.png 8 32

Primary tab right background, normal tabs/LargeNormal.png 398 32

Primary tab left background, normal tabs/LargeNormalLeft.png 8 32

Primary tab right background, emphasized tabs/LargeEmph.png 300 24

Primary tab left background, emphasized tabs/LargeEmphLeft.png 8 24

Primary tab right background, hover tabs/LargeOver.png 398 32

Primary tab left background, hover tabs/LargeOverLeft.png 8 32

Primary tab right background, selected tabs/LargeSelected.png 398 32

Primary tab left background, selected tabs/LargeSelectedLeft.png 8 32

Secondary Tabs background tabs/MediumBar.png 8 26

Secondary tab right background, disabled tabs/MediumDisabled.png 398 26

Secondary tab left background, disabled tabs/MediumDisabledLeft.pn
g

8 26

Secondary tab right background, normal tabs/MediumNormal.png 398 26

Secondary tab left background, normal tabs/MediumNormalLeft.png 8 26

Secondary tab right background, 
emphasized

tabs/MediumEmph.png 300 22

Secondary tab left background, emphasized tabs/MediumEmphLeft.png 8 22

Secondary tab right background, hover tabs/MediumOver.png 398 26

Secondary tab left background, hover tabs/MediumOverLeft.png 8 26

Table 9 Throughout (continued)

Image Description File Width Height
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Secondary tab right background, selected tabs/MediumSelected.png 398 26

Secondary tab left background, selected tabs/MediumSelectedLeft.pn
g

8 26

Tertiary Tabs background tabs/SmallBar.png 8 18

Tertiary tab right background, disabled tabs/SmallDisabled.png 398 18

Tertiary tab left background, disabled tabs/SmallDisabledLeft.png 8 18

Tertiary tab right background, normal tabs/SmallNormal.png 398 18

Tertiary tab left background, normal tabs/SmallNormalLeft.png 8 18

Tertiary tab right background, emphasized tabs/SmallEmph.png 300 20

Tertiary tab left background, emphasized tabs/SmallEmphLeft.png 8 20

Tertiary tab right background, hover tabs/SmallOver.png 398 18

Tertiary tab left background, hover tabs/SmallOverLeft.png 8 18

Tertiary tab right background, selected tabs/SmallSelected.png 398 18

Tertiary tab left background, selected tabs/SmallSelectedLeft.png 8 18

Small button right background, Disabled buttons/SmallDisabled.png 301 15

Small button left background, Disabled buttons/
SmallDisabledLeft.png

6 15

Small button right background, Normal buttons/SmallNormal.png 301 15

Small button left background, Normal buttons/
SmallNormalLeft.png

6 15

Small button right background, Emphasized buttons/SmallEmph.png 301 15

Table 9 Throughout (continued)

Image Description File Width Height
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Small button left background, Emphasized buttons/SmallEmphLeft.png 6 15

Small button right background, Hover buttons/SmallOver.png 301 15

Small button left background, Hover buttons/SmallOverLeft.png 6 15

Small button right background, Down buttons/SmallDown.png 301 15

Small button left background, Down buttons/SmallDownLeft.png 6 15

Medium button right background, Disabled buttons/MediumDisabled.png 303 20

Medium button left background, Disabled buttons/
MediumDisabledLeft.png

6 20

Medium button right background, Normal buttons/MediumNormal.png 303 20

Medium button left background, Normal buttons/
MediumNormalLeft.png

6 20

Medium button right background, 
Emphasized

buttons/MediumEmph.png 303 20

Medium button left background, 
Emphasized

buttons/MediumEmphLeft.png 6 20

Medium button right background, Hover buttons/MediumOver.png 303 20

Medium button left background, Hover buttons/MediumOverLeft.png 6 20

Medium button right background, Down buttons/MediumDown.png 303 20

Medium button left background, Down buttons/MediumDownLeft.png 6 20

Large button right background, Disabled buttons/LargeDisabled.png 303 22

Large button left background, Disabled buttons/
LargeDisabledLeft.png

6 22

Large button right background, Normal buttons/LargeNormal.png 303 22

Table 9 Throughout (continued)

Image Description File Width Height
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Large button left background, Normal buttons/
LargeNormalLeft.png

6 22

Large button right background, Emphasized buttons/LargeEmph.png 303 22

Large button left background, Emphasized buttons/LargeEmphLeft.png 6 22

Large button right background, Hover buttons/LargeOver.png 303 22

Large button left background, Hover buttons/LargeOverLeft.png 6 22

Large button right background, Down buttons/LargeDown.png 303 22

Large button left background, Down buttons/LargeDownLeft.png 6 22

Table 9 Throughout (continued)

Image Description File Width Height

Table 10 Sign-in page

Image Description File Width Height

Graphic for lower left checkerboard square signin_image.png 100 100

Company logo, large signin_logo.png 100 to
300

50 to 
100

Table 11 Banner

Image Description File Width Height

Background for application banner, tiled 
horizontally

mastheadBG.png 40 40

Logo overlaid on application banner at left masthead_logo.png 76 39

Table 12 Configuration View panel

Image Description File Width Height

Expand/Collapse buttons, Disabled buttons/
CButtonDisabledLeft.png

6 13

Expand/Collapse buttons, Normal buttons/
CButtonNormLeft.png

6 13
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Expand/Collapse buttons, Emphasized buttons/
CButtonEmphLeft.png

6 13

Expand/Collapse buttons, Hover buttons/
CButtonOverLeft.png

6 13

Expand/Collapse buttons, Down buttons/
CButtonDownLeft.png

6 13

Collapse, Disabled buttons/
CCButtonDisabled.png

24 13

Collapse, Normal buttons/CCButtonNorm.png 24 13

Collapse, Emphasized buttons/CCButtonEmph.png 24 13

Collapse, Hover buttons/CCButtonOver.png 24 13

Collapse, Down buttons/CCButtonDown.png 24 13

Expand, Disabled buttons/
CEButtonDisabled.png

24 13

Expand, Normal buttons/CEButtonNorm.png 24 13

Expand, Emphasized buttons/CEButtonEmph.png 24 13

Expand button, Hover buttons/CEButtonOver.png 24 13

Expand button, Down buttons/CEButtonDown.png 24 13

Table 12 Configuration View panel (continued)

Image Description File Width Height

Table 13 Configuration View tree

Image Description File Width Height

Vdisk (used for all, not just SAS) tree/arraysas.png 29 20

Enclosure tree/enclosure.png 29 20

Host tree/initiator.png 29 20
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System tree/system.png 29 20

Tree item tree/tv-item.png 16 22

Tree last item tree/tv-item-last.png 16 22

Tree collapsible item tree/tv-collapsable.png 16 22

Tree last collapsible item tree/tv-collapsible-last.p
ng

16 22

Tree expandable item tree/tv-expandable.png 16 22

Tree last expandable item tree/
tv-expandable-last.png

16 22

Vertical navigation line tree/tv-vline.png 16 22

Volume tree/vol.png 29 20

Table 13 Configuration View tree (continued)

Image Description File Width Height

Table 14 Dialog

Image Description File Width Height

Action success success.png 46 46

Informational message message.png 46 46

Warning warning.png 46 46

Error error.png 46 46

Action failure failure.png 46 46

Confirm confirm.png 46 46

Animated progress/working bar progress_bar_small.gif 150 10



32 Customizable files

Dialog close dialog/
dialog-titlebar-close.png

20 20

Dialong close, hover dialog/dialog-titlebar-clo
se-hover.png

20 20

Table 14 Dialog (continued)

Image Description File Width Height

Table 15 Status

Image Description File Width Height

Severity, major status_major_icon.png 15 15

Severity, major status_major_icon_small
.png

10 10

Severity, informational status_informational_icon
.png

15 15

Severity, informational status_informational_icon_
small.png

10 10

Bad & event severity, critical status_critical_icon.png 15 15

Bad & event severity, critical status_critical_icon_small
.png

10 10

Degraded & event severity, minor status_minor_icon.png 15 15

Degraded & event severity, minor status_minor_icon_small
.png

10 10

Normal status_normal_icon.png 15 15

Normal status_normal_icon_small
.png

10 10

Unknown status_unknown_icon.png 15 15

Unknown status_unknown_icon_small
.png

10 10
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Table 16 All panels

Image Description File Width Height

Panel background, tiled (makes graphic 
border)

DarkGrayPanel.png 8 6

Table 17 Panel content

Image Description File Width Height

Background for right hand content panel title 
bar

overviewtitle.png 2000 46

Table 18 Panel left

Image Description File Width Height

Background for left hand panel title bars bartitle.png 800 24

Table 19 Panel right

Image Description File Width Height

Background for right hand panel title bar bartitle_large.png 2000 36

Help/button helpIcon.png 18 18

Animated progress/working bar progress_bar_small.gif 150 10

Table 20 Panel separator

Image Description File Width Height

Drag handle for resizing left and right 
panels horizontally

e_clear_resize.png 6 200

Table 21 Panel status

Image Description File Width Height

Status panel background, tiled grey_panel_bg.gif 20 20
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Table 22 Help

Image Description File Width Height

Help navigation helpNav.png 15 15

Help close helpclose.png 15 15

Help close, hover helpclose.gif 15 15

Help next helpnext.png 15 15

Help previous helpprev.png 15 15

Help pin helppin-up2.png 15 15

Help pinned helppin-down2.png 13 15

Left help divider helpDividerLeft.gif 10 30

Left help divider, hover helpDividerLeftHover.gif 10 30

Right help divider helpDividerRight.gif 10 30

Right help divider, hover helpDividerRightHover.gif 10 30

Table 23 Link

Image Description File Width Height

Link up

Link connected, system up

linkConnectedSysUp.png 72 36

Link connected, system down linkConnectedSysDown.png 72 36

Link down linkDown.png 72 36

Link disconnected, system up linkDisconnectedSysUp.png 72 36

Link disconnected, system down linkDisconnectedSysDown.pn
g

72 36
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